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Glossary 

BGS British Geological Survey: An organisation providing expert advice in all 
areas of geosciences to the UK government and internationally 

COWI Danish international consulting group within engineering, economics and 
environmental science through which drone imagery was provided in 
2016 to HOT 

DE Data Entry; the inputting of data or information into a computer, here it is 
often used to describe ‘data entry specialists’ who collect data in the field 
using mobile devices 

DMD Disaster Management Department, Prime Minister’s Office of Tanzania, 
focused on disaster risk 

DRM Disaster Risk Management; the application of disaster risk reduction 
policies and/or strategies 

DRR Disaster Risk Reduction; disaster risk reduction is aimed at preventing 
new and reducing existing disaster risk and managing residual risk, all of 
which contribute to strengthening resilience and therefore to the 
achievement of sustainable development 

EO Earth Observation; the gathering of information about Earth’s physical, 
chemical and biological systems via remote sensing technologies, usually 
involving satellites carrying imaging devices 

FATHOM Provides innovative flood modelling and analytics, based on extensive 
flood risk research 

GCRF Global Challenges Research Fund 

GED4ALL Global Exposure Database for All; an open global database for hosting 
exposure information for multiple-hazard impact assessment 

GEM Global Earthquake Model; a non-profit organisation focused on the pursuit 
of earthquake resilience worldwide 

GFDRR Global Facility for Disaster Risk Reduction and Recovery; a global 
partnership that helps developing countries better understand and reduce 
their vulnerability to natural hazards and climate change 

GIS Geographic Information System; a conceptualised framework that 
provides the ability to capture and analyse spatial and geographic data 

GNSS Global Navigation Satellite System; a satellite navigation system with 
global coverage; provides geolocation and time information to a receiver 
anywhere on or near the Earth where there is an unobstructed line of 
sight to four or more satellites 

GPS Global Positioning System; a satellite-based radio navigation system 
owned by the United States government and operated by the United 
States Space Force 

HOT Humanitarian OpenStreetMap Team; a global non-profit organisation that 
uses collaborative technology to create OSM maps for areas affected by 
disasters 

InaSAFE Free open software that produces realistic natural hazard impact 
scenarios for better planning, preparedness and response activities 

ImageCat International risk management innovation company supporting the global 
risk and catastrophe management needs of the insurance industry, 
governments and NGOs 

IPP International Partnership Programme; the UK Space Agency’s 
International Partnership Programme (IPP) is a £30M per year 
programme, which uses expertise in space-based solutions, applications 
and capability to provide a sustainable economic or societal benefit to 
emerging nations and developing economies 

JOSM Java OpenStreetMap; free Java software desktop editing tool for OSM 
data 
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KLL Kathmandu Living Labs; a living lab and non-profit civic technology 
company based in Kathmandu, Nepal that primarily works on mobile 
technology and mapping 

LDC Least Developed Country on the Organisation for Economic Co-operation 
and Development's (OECD) Development Assistance Committee (DAC) 
list 

M Milestone, related to work package deliverable 

Mapathon Coordinated mapping event where individuals learn about OSM, and 
make edits to the map through remote digitising of satellite imagery 

METEOR Modelling Exposure Through Earth Observation Routines; a three-year 
project funded by the UK Space Agency to develop innovative application 
of Earth Observation (EO) technologies to improve understanding of 
exposure and multihazards impact with a specific focus on the countries 
of Nepal and Tanzania 

NGO Non-Governmental Organisation; organisations which are independent of 
government involvement 

NSET National Society for Earthquake Technology, non-governmental 
organisation working on reducing earthquake risk in Nepal and abroad 

ODA Official Development Assistance; government aid that promotes and 
specifically targets the economic development and welfare of developing 
countries 

ODbl Open Database License; a copyleft license agreement intended to allow 
users to freely share, modify, and use a database while maintaining this 
same freedom for others 

ODK OpenDataKit; mobile application questionnaire form for collecting data 

OMDTZ OpenMap Development Tanzania: A registered NGO based in Dar es 
Salaam and operating across Tanzania. Since 2017, OMDTZ has 
promoted a number of community mapping projects 

OMK OpenMapKit; mobile application that works with ODK to collect data in 
OSM 

OPM Oxford Policy Management, organisation focused on sustainable project 
design and implementation for reducing social and economic 
disadvantage in low-income countries 

OSM OpenStreetMap, a collaborative project to create a free and open editable 
map database of the world 

OSMCha OpenStreetMap Changeset Analyzer; a web tool to help mappers analyse 
and review data changes to OSM. The objective of the tool is to help 
detect vandalism and act on bad changes to the map data 

OSMF OpenStreetMap Foundation; a not-for-profit organisation that supports the 
OpenStreetMap Project 

Osmose OpenStreetMap Oversight Search Engine; one of many quality assurance 
tools available to detect issues in OpenStreetMap data. It detects a very 
wide range of issue types 

PDC Pacific Data Center; an applied research centre managed by the 
University of Hawaii, PDC is continuously developing new technologies 
and best practices to help our many global partners effectively mitigate, 
prepare for, respond to, and recover from disasters 

POSM Portable OpenStreetMap; project to bring together assorted 
OpenStreetMap tools onto a portable device which works without an 
internet connection 

QA Quality Assurance specialist; people who ensure that the data is being 
collected correctly and to a high standard, often reviewing data after 
collection 

QGIS Free open source desktop geographic information system 

Ramani Huria A community mapping project based in Dar Es Salaam, Tanzania; Swahili 
for “open map” 



iv 

SDGs Sustainable Development Goals; these goals were set up in 2015 by the 
United Nations General Assembly and are intended to be achieved by the 
year 2030 

TS Team Supervisor; person responsible for managing and supervising 
teams, they possess high degrees of technical proficiency 

UAV Unmanned Aerial Vehicle; an aircraft without a human pilot on board, 
often simply referred to as ‘drones’ 

UKSA United Kingdom Space Agency; an executive agency of the Government 
of the United Kingdom, responsible for the United Kingdom's civil space 
programme 

WASH Water, Sanitation and Hygiene; universal, affordable and sustainable 
access to WASH is a key public health issue within international 
development and is the focus of Sustainable Development Goal 6 

WP Work Package; discrete sets of activities within the METEOR Project, 
each work package is led by a different partner and has specific 
objectives 
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Foreword 

This report is the published product of a study by Humanitarian OpenStreetMap Team (HOT) as 
part of the Modelling Exposure Through Earth Observation Routines (METEOR) project led by 
British Geological Survey (BGS). 

 

METEOR is grant-funded by the UK Space Agency’s International Partnership Programme 
(IPP), a >£150 million programme which is committed to using the UK’s space sector research 
and innovation strengths to deliver sustainable economic, societal, and environmental benefit to 
those living in emerging and developing economies. IPP is funded from the Department for 
Business, Energy and Industrial Strategy’s (BEIS) Global Challenges Research Fund (GCRF). 
This £1.5 billion Official Development Assistance (ODA) fund supports cutting-edge research 
and innovation on global issues affecting developing countries. ODA-funded activity focuses on 
outcomes that promote long-term sustainable development and growth in countries on the 
OECD Development Assistance Committee (DAC) list. IPP is ODA compliant, being delivered in 
alignment with UK Aid Strategy and the United Nations’ (UN) Sustainable Development Goals 
(SDGs).  

 

The objective of this report is to outline the ground data collection for Dar es Salaam, Tanzania 
using the protocols developed in M4.3 (O’Hara, 2019) for crowd-sourcing of exposure data for 
OpenStreetMap within the METEOR project. 
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Summary 

This report describes a specific piece of work conducted by Humanitarian OpenStreetMap 
Team (HOT) as part of the METEOR (Modelling Exposure Through Earth Observation 
Routines) project, led by British Geological Survey (BGS) with collaborative partners Oxford 
Policy Management Limited (OPM), SSBN Limited, The Disaster Management Department, 
Office of the Prime Minister – Tanzania (DMD), The Global Earthquake Model Foundation 
(GEM), The Humanitarian OpenStreetMap Team (HOT), ImageCat and the National Society for 
Earthquake Technology (NSET) – Nepal. 

The 3-year project was funded by UK Space Agency through their International Partnership 
Programme, details of which can be located in the Foreword, and was completed in 2021. 

The project aimed to provide an innovative solution to disaster risk reduction, through 
development of an innovative methodology of creating exposure data from Earth Observation 
(EO) imagery to identify development patterns throughout a country and provide detailed 
information when combined with population information. Level 1 exposure was developed for all 
47 least developed countries on the OECD DAC list, referred to as ODA least-developed 
countries in the METEOR documentation, with open access to data and protocols for their 
development. New national detailed exposure and hazard datasets were also generated for the 
focus countries of Nepal and Tanzania and the impact of multiple hazards assessed for the 
countries. Training on product development and potential use for Disaster Risk Reduction was 
performed within these countries with all data made openly available on data platforms for wider 
use both within country and worldwide. 

This report (M4.5/P) is the fifth report generated by HOT for the work package on Inputs and 
Validation (WP4) led by HOT. The other 7 METEOR work packages included, Project 
Management (WP1 – led by BGS), Monitoring and Evaluation (WP2 – led by OPM), EO data for 
exposure development (WP3 - led by ImageCat), Vulnerability and Uncertainty (WP5 - led by 
GEM), Multiple hazard impact (WP6 – led by BGS), Knowledge sharing (WP7 – led by GEM) 
and Sustainability and capacity building (WP8 – led by ImageCat). 
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1. METEOR Project 

1.1. PROJECT SUMMARY 

Project Title Modelling Exposure Through Earth Observation Routines (METEOR): 
EO-based Exposure, Nepal and Tanzania 

Starting Date 08/02/2018 

Duration 36 months 

Partners UK Partners: The British Geological Survey (BGS) (Lead), Oxford 
Policy Management Limited (OPM), SSBN Limited 

International Partners: The Disaster Management Department, Office of 
the Prime Minister – Tanzania, The Global Earthquake Model (GEM) 
Foundation, The Humanitarian OpenStreetMap Team (HOT), 
ImageCat, National Society for Earthquake Technology (NSET) – Nepal 

Target Countries Nepal and Tanzania for “level 2” results and all 47 Least Developed 
ODA countries for “level 1” data 

IPP Project IPPC2_07_BGS_METEOR 

Table 1: METEOR Project Summary 

1.2. PROJECT OVERVIEW 

At present, there is a poor understanding of population exposure in some Official Development 
Assistance (ODA) countries, which causes major challenges when making Disaster Risk 
Management decisions. Modelling Exposure Through Earth Observation Routines (METEOR) 
takes a step-change in the application of Earth Observation exposure data by developing and 
delivering more accurate levels of population exposure to natural hazards. METEOR is 
delivering calibrated exposure data for Nepal and Tanzania, plus ‘Level-1’ exposure for the 
remaining Least developed Countries (LDCs) ODA countries. Moreover, we are: (i) developing 
and delivering national hazard footprints for Nepal and Tanzania; (ii) producing new vulnerability 
data for the impacts of hazards on exposure; and (iii) characterising how multi-hazards interact 
and impact upon exposure. The provision of METEOR’s consistent data to governments, town 
planners and insurance providers will promote welfare and economic development and better 
enable them to respond to the hazards when they do occur. 

METEOR is co-funded through the second iteration of the UK Space Agency’s (UKSA) 
International Partnership Programme (IPP), which uses space expertise to develop and deliver 
innovative solutions to real world problems across the globe. The funding helps to build 
sustainable development while building effective partnerships that can lead to growth 
opportunities for British companies. 

 

1.3. PROJECT OBJECTIVES 

METEOR aims to formulate an innovative methodology of creating exposure data through the 
use of EO-based imagery to identify development patterns throughout a country. Stratified 
sampling technique harnessing traditional land use interpretation methods modified to 
characterise building patterns can be combined with EO and in-field building characteristics to 
capture the distribution of building types. These protocols and standards will be developed for 
broad application to ODA countries and will be tested and validated for both Nepal and 
Tanzania to assure they are fit-for-purpose. 

Detailed building data collected on the ground for the cities of Kathmandu (Nepal) and Dar es 
Salaam (Tanzania) will be used to compare and validate the EO generated exposure datasets. 
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Objectives of the project look to: deliver exposure data for 47 of the least developed ODA 
countries, including Nepal and Tanzania; create hazard footprints for the specific countries; 
create open protocol; to develop critical exposure information from EO data; and capacity-
building of local decision makers to apply data and assess hazard exposure. The eight work 
packages (WP) that make up the METEOR project are outlined below in section 1.4. 

 

1.4. WORK PACKAGES 

Outlined below are the eight work packages that make up the METEOR project, which are led 
by various partners. Table 2 provides an overview of the work packages together with a brief 
description of what each of the work packages cover. HOT is leading WP.4 Inputs and 
Validation, which focuses on the collection of exposure data in Kathmandu in Nepal and Dar es 
Salaam in Tanzania (Table 2). This data will assist with the validation and calibration of national 
exposure datasets created through the classification of building patterns from satellite imagery 
carried out by ImageCat in WP3 

Work 
Package 

Title  Lead Overview 

WP1  Project 
Management 

BGS Project management, meetings with UKSA, 
quarterly reporting and the provision of feedback 
on project deliverables and direction across 
primary stakeholders.  

WP2 Monitoring and 
Evaluation 

OPM Monitoring and evaluation of the project and its 
impact, using a theory of change approach to 
assess whether the associated activities are 
leading to the desired outcome. 

WP3 EO Data for 
Exposure 
Development  

ImageCat EO-based data for exposure development, 
methods and protocols of segmenting/classifying 
building patterns for stratified sampling of building 
characteristics. 

WP4 Inputs and 
Validation 

HOT Collect exposure data in Kathmandu and Dar es 
Salaam to help validate and calibrate the data 
derived from the classification of building patterns 
from EO-based imagery. 

WP. Vulnerability and 
Uncertainty 

GEM Investigate how assumptions, limitations, scale 
and accuracy of exposure data, as well as 
decisions in data development process lead to 
modelled uncertainty. 

WP6 Multiple Hazard 
Impact 

BGS Multiple hazard impacts on exposure and how 
they may be addressed in disaster risk 
management by a range of stakeholders. 

WP7 Knowledge 
Sharing 

GEM Disseminate to the wider space and development 
sectors through dedicated web-portals and use of 
the Challenge Fund open databases. 

WP8 Sustainability and 
Capacity-Building 

ImageCat Sustainability and capacity-building, with the 
launch of the databases for Nepal and Tanzania 
while working with in-country experts. 

Table 2: Overview of METEOR Work Packages 
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1.5. IN-SITU INPUTS AND VALIDATION 

The project WP led by HOT is broken down into six deliverables, which are focused on the 
mapping of exposure data for the cities of Kathmandu and Dar es Salaam in OpenStreetMap 
(OSM). These involve importing existing data into OSM, the remote mapping of building 
footprints and road networks, drafting protocols for crowdsourcing exposure data, collecting 
detailed attribute information on the ground and producing a final report (Table 3). 

Deliverable Title Overview 

M4.1 Import Existing Data into 
OSM 

Review and assess the suitability of existing open 
datasets for import into OSM for Kathmandu and Dar es 
Salaam.  

M4.2 EO Mapping of Exposure 
Data 

Remote mapping of building footprints and road 
networks in OSM for Kathmandu and Dar es Salaam. 

M4.3 Protocols for Crowdsourcing 
Exposure Data 

Draft protocols for the crowdsourcing of exposure data 
in OSM, covering data imports, remote mapping and 
ground data collection. 

M4.4 Ground Data Collection using 
Protocols I 

Collect exposure data on the ground for Kathmandu 
using a data model developed in line with the 
requirements for WP.3 

M4.5 Ground Data Collection using 
Protocols II 

Collect exposure data on the ground for Dar es Salaam 
using a data model developed in line with the 
requirements for WP.3 

M4.6 Final Report Deliver a final version of M4.3 along with the resulting 
data from M4.4. and M4.5. 

Table 3: Overview of HOT Work Package 
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2. OpenStreetMap 

2.1. WHAT IS IT? 

OSM is a crowdsourced geospatial database of the world built largely by volunteers and 
professionals digitising aerial imagery, collecting attribute information on the ground and 
liberating existing public sources of geospatial data. Known as the ‘Wikipedia’ of maps, the data 
is freely accessible to all under the Open Database License (ODbL)1, meaning that it can be 
queried, used, manipulated, contributed to and redistributed in any form. OSM is the ideal 
database for humanitarian efforts and disaster management, as it is a great source of 
geographic baseline data for many cities around the globe, especially in countries with 
emerging economies that are not always on the map. 

 

2.2. OPEN DATA 

The ODbL license is a copyleft ("share alike") agreement intended to allow users to freely share, 
modify, and use a database while maintaining this same freedom for others. Published by Open 
Data Commons, part of the Open Knowledge Foundation2, the ODbL license enables OSM to 
be a source of powerful geospatial data to make change, particularly in ODA countries where a 
potential lack of internal funds and skill sets make it difficult to create up-to-date exposure data 
themselves. Such data is necessary to conduct hazard impact risk assessments and carry out 
informed appropriate disaster management decisions. One project may focus on creating data 
in OSM for a specific purpose, but this data can then be used by anyone for their area of 
interest. This freedom of use is outlined on the ODbL website3 (Open Data Commons, 2018): 

 

You are free: 

❖ To Share: To copy, distribute and use the database 

❖ To Create: To produce works from the database 

❖ To Adapt: To modify, transform and build upon the database 
 

As long as you: 

❖ Attribute: You must attribute any public use of the database, or works produced from the 
database, in the manner specified in the ODbL. For any use or redistribution of the 
database, or works produced from it, you must make clear to others the license of the 
database and keep intact any notices on the original database 

❖ Share-Alike: If you publicly use any adapted version of this database, or works produced 
from an adapted database, you must also offer that adapted database under the ODbL 

❖ Keep open: If you redistribute the database, or an adapted version of it, then you may use 
technological measures that restrict the work (such as DRM) as long as you also 
redistribute a version without such measures 

 

  

 

1 https://opendatacommons.org/licenses/odbl/ 
2 https://okfn.org/ 
3 https://opendatacommons.org/licenses/odbl/summary/index.html 
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2.3. DATA STRUCTURE 

Geospatial data is stored in OSM as vectors, with three types of elements: 

1. Nodes, which represent a point on the surface of the earth 
2. Ways, which are sets of ordered nodes that can form lines or polygons 
3. Relations, which are sets of nodes, ways and/or relations as members that are used to 

define logical or geographic relationships between other elements 
 

 

Nodes 

 

Ways 

 

Relations 

 

Each of these elements can have any number of key=value tags, that represents the attribute 

information for a given feature. For example, a post office may be represented by a way with the 
tags building=yes and amenity=post_office, to help identify the purpose of the 

building. 

2.4. WHY USE IT? 

The most common question people ask is: Why would you use OpenStreetMap if there is 
Google Maps?4 These platforms have many similarities and address the same basic human of 

spatially knowing where things are. In short, OSM represents an open approach to how data is 
collected and distributed, which makes it fast, free, flexible and widespread; an ideal 
combination for development application among others. 

 

In the case of Haiti, the OSM community needed just a few hours to remotely digitise 
earthquake affected areas from satellite imagery, in contrast to commercial maps that had no 
way of responding in such a short period. The thousands of active volunteers around the globe 
are what made this possible, and the fact that every update is immediately visible to all other 
users, and is also version controlled. In many cases, the OSM community has been able to 
achieve even higher detail than any other map source. 

 

The very idea behind OSM was to solve the problem of data restriction by using a Wikipedia 
model. Each edit made in OSM is owned by the community, whereas each change made in 
commercial map is owned by the providers. Data in commercial maps is copyrighted and so it 
can be subject to licensing fees and contractual restrictions. OSM is, and always will be, 
available for free. This open access to geospatial data makes it easy for researchers, 
governments, disaster management agencies and policy implementers to work collectively from 
the same database. 

 

OSM is also ready for any kind of operation. Many major organisations are choosing OSM for 
their maps because it allows for customisation based on need. It has been used to collect 
functioning and non-functioning water facilities in northern Uganda, to mapping hundreds of 
thousands of shelters in Bangladesh, to planning logistics for a Yellow Fever campaign in the 
Democratic Republic of Congo and mapping the exposure information of infrastructure for 

 

4 https://welcome.openstreetmap.org/ 
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hazard impact. It allows access to all of the map offline and can be formatted in local languages, 
transcending national boundaries. 

 

Most importantly, OSM emphasises local knowledge across the globe. The barrier to entry is 
low, and there are many ways to contribute that do not require access to the latest technology. 
The result is a map made by local experts. OSM provides global map data in a unified tagging 
schema, although there are some local variations, this allows for consistency from country to 
country, for a truly global map. 

 

 

3. Participatory Mapping 

Participatory mapping a phrase commonly used in the OSM community. It is the creation of 
maps by local communities. They are visual representations of what a community perceives as 
its environment and the significant features within it. Participatory mapping is based on the 
premise that local communities possess expert knowledge of their surroundings. 

 

Often this process is supported by organisations, with a target goal and funds to assist with the 
research and direction, depending on the purpose of the data creation. The emphasis, however, 
is always on providing skills for the community to create the maps themselves in order to 
represent the spatial knowledge of local citizens. Participatory mapping is at the core of HOT 
and their work, where local teams are the experts to create the necessary data in OSM. 

 

Participatory mapping relates to fostering a collaborative approach. The primary ingredient in 
the success of an open mapping project is the cultivation and care of a strong network of 
partners across the range of communities and institutions that have a stake in the project. 
These partnerships are critical for the implementation, uptake, and sustainability of open 
mapping projects. They can lead to shared investment of resources and technical expertise, 
innovative use cases for open data, increased legitimacy for the project, and stability over time. 
Because the open mapping ecosystem is a global phenomenon, it is likely that at the start of 
any project, there will be a pre-existing group of individuals and organisations already mapping 
in the target area. With proper outreach and engagement, these groups can be a powerful 
resource. Including them early in the planning and design phases of a project will help increase 
their sense of ownership and improve the likelihood of successful collaboration. 

 

Government agencies responsible for areas as diverse as national statistics, urban planning, 
transportation, public health, environment and natural resource management, and disaster 
response have all benefited from working with open mapping and can bring valuable resources, 
expertise, and authority to a mapping project. The OSM community is active globally and will, in 
many cases have a local presence with experience mapping in the area, technical knowledge 
about mapping, and a group of passionate volunteers who may be willing to participate. 

 

As is the case for crowd-sourcing the regional exposure data in the cities of Kathmandu and Dar 
es Salaam for the METEOR project. Kathmandu Living Labs (KLL) is a local company who has 
been involved with the OSM community for years, having worked on numerous projects with the 
Nepalese government. While Ramani Huria is a community-based mapping initiative that began 
in Dar es Salaam training university students and local community members to create OSM 
maps of the most flood-prone areas of the city, in an effort to help combat the impact. 
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4. Ground Data Collection 
Data collection in the city of Dar es Salaam and the neighbouring region of Pwani was 
conducted by HOT and OMDTZ following the outlined protocols in O’Hara (2019). The protocols 
focus on the addition of detailed attribute information of buildings observed from the ground to 
building footprints that were remotely digitised in OSM using aerial imagery. The methodology 
applied by HOT for the ground data collection is briefly outlined below and expanded through 
the following sections. 

No. Step Description Date 

1 Digitisation Remote mapping of the selected regions Oct - Dec 2018 

2 Data Model Development of localised data model for Dar es Salaam January 2019 

3 Mapping Team Recruitment of a local mapping team January 2019 

4 Area of Interest Generation of randomised sampling points per 

homogeneous zone 

January 2019 

5 Survey 

Authorisation 

Authorisation from district officials to survey areas of interest January 2019 

6 Tool 

Preparation 

Preparation of data collection tools January 2019 

7 Team Training Training with local structural engineers and use of data 

collection tools 

February 2019 

8 Data 

Management 

Data management setup through dedicated online server February 2019 

9 Ground Survey Collection of identified building attributes February and 

March 2019 

10 Data Validation 

and Quality 

Data validation, spot checks and quality assurance  April 2019 

11 Upload Data Upload final data to OSM   April 2019 

Table 4: Outline of OSM Ground Data Collection in Tanzania 

 

The first step of any ground data collection is to create a data model, which was localised for 
the context of Dar es Salaam with the assistance of local structural engineers from Ardhi 
University who provided insight on types of commonly found buildings within the city. Once the 
data model was finalised, the mapping team was put together and the data collection tools 
prepared along with the creation of customised questionnaire forms following the localised data 
model. During this time, the team leaders determined the area of interest for collecting data 
through the generation of random sampling points within each of the homogeneous 
development zones, as well as ensuring access with the appropriate authorities. 

 

Training for the team on how to use the surveying tools to capture the data on the ground was 
then carried out, along with the establishment of a data management system where the 
completed questionnaires could be organised, hosted and backed through an online server. The 
data collection commenced on the ground once everything was in order, which was then 
followed by a series of data validation rounds, as well as random spot checks by team leaders. 



8 

A final round of data validation and assessment of the data quality assurance was conducted 
before uploading the information to OSM. 

 

In total, the various steps involved with the ground data collection in Dar es Salaam took around 
6 months, with the development of the data model starting in October 2018, and the ground 
surveying taking place from February to April 2019. The final phase of the project, which 
focuses on data validation, spot checking, and uploading the final data to OSM took place from 
March to April 2019. 

4.1. DATA MODEL 

The data model used for the collection of exposure information in Dar es Salaam was adopted 
from the model used by KLL in Kathmandu. This was derived from the Global Exposure 
Database for All (GED4ALL) data model, which was initially conceived through the second 
round of the GFDRR Challenge Fund.5 The Challenge Fund aims to decrease disaster risk 
management costs and increase resilience by developing frameworks that facilitates a multi-
hazard view of risk, taking into account the effects of volcanoes, floods, tsunamis, storms and 
cyclones on the structural integrity of buildings. HOT, in collaboration with the Global 
Earthquake Model (GEM) and ImageCat, assisted with the integration of OSM data into 
GED4ALL at the building level, by aligning the appropriate data tags in OSM to the identified 
taxonomy attributes6. 

 

Two versions of the GED4ALL data model were created, a core data model containing an 
exhaustive list of structural building features that can be impacted by the hazards listed above 
and a simplified version. The simplified version is based on the most common, relevant and 
easy to define features of buildings, which were selected to help reduce the comprehensive 
multi-hazard risk assessment taxonomy for less experienced surveyors. This is the version that 
was adapted and used for the METEOR project. Data collection efforts are much more effective 
when the attributes required are kept to a minimum, where possible. This allows the surveyors 
to focus on the quality rather than the quantity of information. Table 5 outlines the simplified 
version of the GED4ALL building taxonomy OSM data model. 

 

As the GED4ALL building taxonomy is designed to be used around the globe, the OSM values 
in the simplified table are merely guidelines to commonly used entries for the identified 
attributes. These values were localised for Dar es Salaam, with the support of a civil engineer 
expert from Ardhi University. His input on structural aspects, such as commonly used building 
materials and lateral load resisting systems within Dar es Salaam were incorporated into the 
METEOR data model, while those generally not found within the area were removed. After 
discussion with the engineer we agreed to add some other proposed descriptions in each 
attribute, for example, we have added many local values in buildings:lateral:material, 
building:lateral:system, roof:shape and roof:materials. The final localised data model used for 
the ground data collection in Dar es Salaam can be seen in Table 6. 

  

 

5 https://www.gfdrr.org/en/challenge-fund 

6 https://wiki.openstreetmap.org/wiki/GED4ALL 
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SIMPLIFIED GED4ALL BUILDING TAXONOMY  

No. GED4ALL  OSM Key OSM Description and Values 

1 Material of the 

Lateral Load 

Resisting 

System 

building:lateral:material=* Proposed lateral load resisting material tag 

(concrete_reinforced, concrete, concrete_steel, 

metal, masonary_reinforced, masonry, 

masonry_confined, earth, earth_reinforced, 

wood, other, unknown) 

2 Lateral Load 

Resisting 

System 

building:lateral:system=* Identify structural system of buildings 

(moment_frame, infilled_frame, braced_frame, 

post_beam, wall, dual_framewall, flat_slab, 

waffle_slab ,infill_flatslab, infill_waffleslab, 

hybrid, unknown)  

3 Height 

 

building:levels=*  Number of above-ground levels of a building 

building:levels:underground=* Proposed tag for number of below-ground 

levels of a building 

building:slope=* Proposed tag for describing the slope of the 

building in degrees 

4 Date of 

Construction or 

Retrofit 

 

building:age=* Proposed age tag, associated with buildings 

(pre_2000, post_2000, unknown) 

building:condition=*  Describe the condition of the building (good, 

average, poor, unknown)  

5 Occupancy 

 

building=*  Describe the building purpose (residential, 

commercial, public, mixed_use, industrial, 

agriculture, assembly, government, 

educational, unknown)  

capacity:persons=*  Describe the number of people a building can 

support 

6 Ground Floor 

Hydrodynamics 

 

ground_floor:openings=* Proposed openings tag, associated with 

building ground floors (yes, no, unknown) 

ground_floor:height=* Proposed height tag in meters, associated with 

building ground floors 

7 Roof 

 

roof:shape=*  Well known roof shapes (flat, pitched, 

monopitch, sawtooth, curved, 

complex_regular, complex_irregular, unknown) 

roof:material=*  Outer material for the building roof (masonry, 

earth, concrete, metal, wood, fabric, slate, 

stone, clay, unknown) 

Table 5: GED4ALL Simplified Building Taxonomy with related OSM key, description and values 

  

http://wiki.openstreetmap.org/wiki/Key:building:levels
http://wiki.openstreetmap.org/wiki/Key:building:condition
http://wiki.openstreetmap.org/wiki/Buildings
https://wiki.openstreetmap.org/wiki/Key:capacity
https://wiki.openstreetmap.org/wiki/Simple_3D_buildings#Roof
http://wiki.openstreetmap.org/wiki/Key:roof:material
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DAR ES SALAAM BUILDING TAXONOMY  

No. Attribute OSM Key OSM Description and Values 

1 Material of the 

Lateral Load 

Resisting 

System 

building:lateral:material=* Proposed lateral load resisting material tag (steel, 

steel-concrete_composite, block, brick, stone, 

corrugated_galvanized_iron, earth, wood, bamboo, 

light_gauge_steel or cold_formed_steel, iron_sheet, 

industrial_troughed_sheet) 

2 Lateral Load 

Resisting 

System 

building:lateral:system=* Identify structural system of buildings 

(moment_resisting_frame, shear_wall, 

braced_frame, framed_concrete_structure, Dual 

system (frame wall), masonry_wall, 

confined_masonry, hybrid)  

3 Height 

 

building:levels=* Number of above-ground levels of a building 

building:levels:undergrou

nd=* 

Number of under-ground levels of a building 

4 Date of 

Construction 

or Retrofit 

 

building:age=* Proposed age tag, associated with buildings 

(pre_2000, post_2000, unknown) 

building:condition=* Describe the condition of the building (good, 

average, poor)  

5 Occupancy 

 

building=* Describe the building purpose (residential, 

commercial, public, mixed_use, industrial, 

agriculture, assembly, government, educational, 

health, construction)  

capacity:persons=* Describe the number of people a building can 

support 

6 Roof 

 

roof:shape=* Well known roof shapes (flat, pitched, monopitch, 

double_pitch, sawtooth, curved, complex_regular, 

complex_irregular, domed, unknown) 

roof:material=* Outer material for the building roof (clay tiles, earth, 

concrete, metal, wood, fabric, slate, stone, 

composite_tiles, cgi, bamboo, thatch, mixed, 

unknown) 

7 Neighbouring 

Condition 

building:neighbour=* Describe the neighbouring condition of the building 

(attached, free_standing) 

8 Geological 

Site Condition 

building:geological_site=* Describe the geological site the building is built 

upon (slopy_land, flood-prone_area, river_bank) 

Table 6: Dar es Salaam Localised Building Taxonomy 

4.2. MAPPING TEAM 

Once the data model was finalised, a team to conduct the data collection on the ground was put 
together. The structure of the team greatly influences the management, efficiency, quality and 
overall success of surveying on the ground, especially when working with large amounts of 
information. A tiered team structure ensures that the data collection can be carried out 
systematically, so that the line of responsibility and guidance is clear. As data collection is 
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crowdsourced through OSM and focuses on the structural engineering of buildings, the 
surveying team for Dar es Salam consisted of HOT and OMDTZ mapping supervisors, field 
mappers, and some structural engineering students to assist with spot checking and validation. 
This allowed for a range of specialised expertise combined with the local knowledge of 
surveyors and residents from Dar es Salaam. 

 

Recruitment of the team began in October 2018, and focused mainly on assembling a team of 
surveyors who had already engaged with various HOT Tanzania Projects and had a basic 
understanding of data collection tools and processes. Therefore, we started digitising buildings 
footprints by using the digitisation team that had been created and has a wide experience in 
digitisation processes. Next, we constructed a field team by February 2019, this team is 
different from those who used in digitisation. Most of the people in this team consisted of recent 
graduates from Ardhi University7 and the University of Dar es Salaam8. 

 

An added advantage of this recruitment was that surveyors had been involved in many of the 
activities within HOT Tanzania projects such as Ramani Huria, and also had a background of 
the planning activities and how buildings are classified in OSM as well as having great 
knowledge of the Dar es Salaam areas and the ward locations. After making sure everyone was 
available in Dar es Salaam we conducted training both in the classroom and with practical 
exercises the same month followed with field mapping by March 2019. 

 

 

Figure 1: Tanzania Mapping Team with Civil Engineering Professor, at HOT/OMDTZ Office. 
Image © HOT Tanzania 

The team project manager was in charge of planning the whole mapping approach, from 
developing the workflow, setting up the tools, hiring the team, conducting the training and 
strategically dividing up the city, helping in reporting as well as overseeing all the data collected 
and validated. Once the work was delegated down the line, the quality assurance specialists 
could focus on ensuring that the data was being collected correctly and to a high standard, 

 

7 http://www.aru.ac.tz/ 

8 https://www.udsm.ac.tz/ 

http://www.aru.ac.tz/
https://www.udsm.ac.tz/
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while providing feedback both down the line to the data entry specialists, and to the project 
manager. 

No. Name Team Position Connected Institute 

1. Dorica Mugusi Team Lead HOT/OMDTZ 

2. Gwantwa Andrew Quantity and Assurance OpenMap Development Tanzania 

3. Dorice Lucas Quantity and Assurance OpenMap Development Tanzania 

4. Jamal Amani Editor OpenMap Development Tanzania 

5. Mariamu Crispo Editor OpenMap Development Tanzania 

6. Nuru Athumani Editor OpenMap Development Tanzania 

7. Samwel Kyando Editor OpenMap Development Tanzania 

8. Frank Charles Editor OpenMap Development Tanzania 

9. Abubakari R 

Kachongo 

Editor OpenMap Development Tanzania 

10. Christina Reuben Editor OpenMap Development Tanzania 

11. Edger Mahali Editor OpenMap Development Tanzania 

12. Aron Martin Quantity and Assurance OpenMap Development Tanzania 

13. Erasto Eliud Editor OpenMap Development Tanzania 

14. Asibwene Kalulunga Editor OpenMap Development Tanzania 

15. Godfrey Faustine Editor OpenMap Development Tanzania 

16. Janeth Mlinga Editor OpenMap Development Tanzania 

17. Neema Kombe Editor OpenMap Development Tanzania 

18 Damon Monyo Editor OpenMap Development Tanzania 

19. Furaha Mrema Editor OpenMap Development Tanzania 

20. Godfrey Hussein Editor OpenMap Development Tanzania 

21. Neema Alphonce Quantity and Assurance OpenMap Development Tanzania 

Table 7: Digitisation team for METEOR project in Tanzania 
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No. Name Team Position Connected Institute 

1. William Evans Global Project Manager Humanitarian OpenStreetMap Team 

2. Emanuel Kombe Project Manager HOT/ OMDTZ 

3. David Mwasaka Quantity & Assurance OpenMap Development Tanzania 

4. Neema Elias Quantity & Assurance OpenMap Development Tanzania 

5. Zaituni Rashid Quantity & Assurance OpenMap Development Tanzania 

6. Paschal Mapera Quantity & Assurance OpenMap Development Tanzania 

7. Evarist Isdory Surveyor OpenMap Development Tanzania 

8. Glory Emanuel Surveyor OpenMap Development Tanzania 

9. Gloria Elevan Surveyor OpenMap Development Tanzania 

10. Asia Abdallah Surveyor OpenMap Development Tanzania 

11. Jackson Hombo Surveyor OpenMap Development Tanzania 

12. Gisella John Surveyor OpenMap Development Tanzania 

13. Debora Chamaku Surveyor OpenMap Development Tanzania 

14. Rashid  Iddi Surveyor OpenMap Development Tanzania 

15. Joan Kamwela Surveyor OpenMap Development Tanzania 

16. William Mponeja Surveyor OpenMap Development Tanzania 

17. Hawa Magongo Surveyor OpenMap Development Tanzania 

18 Felister Rwehumbiza Surveyor OpenMap Development Tanzania 

19. Jeremiah Baptister Surveyor OpenMap Development Tanzania 

20. Josephina Tinuga Surveyor OpenMap Development Tanzania 

21. Hashiru Mutaremwa Surveyor OpenMap Development Tanzania 

22. Ibrahim Alphonce Surveyor OpenMap Development Tanzania 

23. Grace Makala Validator Ardhi University 

24. Halima Rajun Kisavul Validator Ardhi University 

25. Joseph Asantemungu Validator Ardhi University 

26. Josephat Mhanga Validator Ardhi University 

26. Magret Naimani Validator Ardhi University 

Table 8: Data Collection Team/Team on the Ground for METEOR project in Tanzania 
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4.3. AREA OF INTEREST 

Dividing up and delegating target areas to the mapping team also plays a large role in 
successfully collecting data on the ground. How the area is split up is dependent on the type of 
mapping initiative, whether it is looking at the city or town as a whole, or whether it is isolated 
sections. For the METEOR project, Dar es Salaam was divided into homogeneous development 
type zones making the area of interest targeted portions of the city. 

 

These areas were classified into homogenous zones by ImageCat, based on structural 
development patterns identified remotely. There were originally 7 zone types identified in Dar es 
Salaam, which include High Urban Development, Industrial Development, Rural Settlement, 
Single Family Residential, Informal Zones, Urban Development, and Natural Forest Land. The 
Natural Forest Land development pattern was eventually discarded for the purposes of this 
project, due to the fact that there were no buildings of any kind to be found in this zone, which 
left 6 homogeneous zones where buildings would be surveyed (Figure 2 and Table 9). 

 

No. Homogenous Zone Type No. Zones Identified 

1 Single Family Residential 11 

2 High Urban Development 4 

3 Industrial Development 11 

4 Informal Settlement 10 

5 Urban Development 4 

6 Rural Settlement 4 

 Total 44 

Table 9: Dar es Salaam Homogeneous Zones 

 

Figure 2: Dar es Salaam Homogeneous Zones © ImageCat, inc. (link to high resolution version) 
Zones defined by ImageCat as part of the METEOR project. Data displayed within OSM © 
OpenStreetMap contributors, licensed under ODbL 

https://drive.google.com/file/d/16KOkpG5Sy3eI_7ZbTcIsq_Ou5Rj44VPN/view
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ImageCat requested that a randomised sampling strategy be applied to the homogenous zone 
types, so that there are 40 randomised points per development type, with 10 buildings surveyed 
around each of the points. These sampling points were used as coordinates on the ground, 
from which the mappers randomly selected 10 buildings to survey and collect data for, following 
the project data model. As there are 6 homogeneous zone types in Dar es Salaam and Pwani, 
ideally a total of 2,400 buildings were to be surveyed keeping the error margin at 5%. 

 

The randomised points were created according to the development zones and a Homogeneous 
Zone Samples file shared by ImageCat. As in O’Hara & Thapa (2019) for Nepal, the best 
approach appeared to be cluster sampling. However, in dense areas with only a few more 
buildings than in our sample selection, there was little point in clustering as virtually all clustered 
buildings would overlap. 

 

Therefore, for three of the zones (Rural Settlement, Single Family Residential, and Urban 
Development) the Tanzania team used random points, following the clustered approach. For the 
other three zones (High Urban Development, Industrial Development, and Informal Settlements) 
they used the QGIS Field Calculator to generate the random buildings. These are 
representative because of the large proportion of chosen buildings to total population (i.e. 
surveying 400 out of 434 buildings in the Industrial Zone). 

  

This means that roughly 2,400 buildings were to be surveyed, though the team added in 
additional buildings to help with the error margin. However, as for the sampling in Nepal, several 
of the sampling points fell within military and government complexes, where ground surveying is 
prohibited and, in such cases, where possible alternative points were chosen. When it was not 
possible to select an alternative point, they were ignored. In the end, a total of 2951 buildings 
were surveyed around 44 sampling areas across the 6 homogeneous zones. In comparison to 
the data collected in Nepal, the points in Dar es Salaam were much further distributed, below 
are a few examples of some of the sampling points. (Figure 3 and Table 10). 

 

For more details regarding the sampling procedure for buildings, the team has prepared a 
“Sampling procedure for buildings_METEOR TZ” tutorial attached in this report as Appendix 3, 
that explains how they approached clustered and non-clustered sampling with open source 
tools. 

 

Note: The team in Tanzania has in fact digitised all of the buildings in the areas provided by 
ImageCat, therefore, there shouldn't have been bias when randomly selecting. This is one of the 
benefits of working in a city that has been thoroughly digitised by past open mapping projects. 

  

https://docs.google.com/document/d/148LUfTt_eE9x1r2cEUIJn83fdAKchRGqwkd4gU_sFhU/edit#heading=h.lernf922o40x
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Figure 3: Dar es Salaam Sampling Points selected from the Dar es Salaam Homogeneous 
Zones randomised sample points © ImageCat, inc., defined by ImageCat as part of the 
METEOR project. Data displayed within OSM © OpenStreetMap contributors, licensed under 
ODbL 

 

No. Homogenous Zone Type No. Buildings Surveyed 

1 Single Family Residential 467 

2 High Urban Development 584 

3 Urban Development 505 

4 Industrial Development 423 

5 Informal Settlement 538 

6 Rural Settlement 434 

 Total 2951 

Table 10: Dar es Salaam Surveyed Buildings 

 

4.4. SURVEY AUTHORISATION 

No official authorisation was required as the surveying teams did not enter any property or 
restricted areas, as well as interview anyone. However, there was a formal request sent to the 
four Municipal Offices in Dar es Salaam, and afterwards the teams informed the local 
government offices of the survey activities that were going to be done. The surveyors informed 
the local government of their intended activities and delivered the permission letter before 
carrying out the ground data collection. This was done at the ward level, and was accompanied 
by a letter of intention composed by OMDTZ/HOT, Municipal (district) and local government. 
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This process is vital to the safety and success of data collection in Tanzania. A copy of the 
authorisation letter can be found below (Figure 4). 
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Figure 4: Surveying Letter of Intention for the Dar es Salaam building sampling 

 

The team was also very conscious of their behaviour and overall code of conduct, carrying out 
their data collection in a respectfully appropriate manner. For example, the surveyors did not 
enquire about the details of building attributes from individuals who did not independently 
volunteer to share this information. 

 

4.5. TOOL PREPARATION 

Surveyors can choose from a number of free and open OSM tools that facilitate on-the-ground 
data collection in both online and offline settings. The tools used by the mapping team in Dar es 
Salaam included the mobile applications OpenDataKit (ODK), OpenMapKit (OMK) and 
Maps.me. ODK9 is an Android application that replaces paper forms used in survey-based data 
gathering, allowing users to easily author, field, and manage mobile data collection solutions. It 
supports a wide range of question and answer types, which can be managed by a set of rules in 
order to help reduce the occurrence of errors during data collection. It is also designed to work 

 

9 https://opendatakit.org 
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well without network connectivity. Once forms have been downloaded, it does not depend on 
the internet again until the collected data needs to be uploaded to a server, or not at all if the 
data is transmitted directly to a desktop. 

 

The biggest portion of preparing ODK for use, is the creation of the customised questionnaire 
that will be read by the tool and presented to the surveyors through their mobile application. The 
questionnaire was created by HOT with the use of a spreadsheet and excel sheet (Figure 6) 
and the localised OSM data model outlined in the previous section. Once the spreadsheet is 
complete, it can be converted into a form for consumption by ODK using XLSForm10 or by 
loading it onto OMK Server, which is detailed in the 4.7 Data Management section below. 

 
  

Figure 5: OpenDataKit Questionnaire (left), OpenMapKit (right) as customised for mapping in 
Dar es Salaam and Pwani 

 

  

 

10 https://opendatakit.org/xlsform/ 
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Figure 6: OpenDataKit Spreadsheet, customised for mapping in Dar es Salaam and Pwani 
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OMK11 (OMK) is a free and an open source tool that is used to create professional quality 
mobile data collection surveys on the ground in OSM. OMK launches directly from ODK and 
allows users to add points of interests and attribute information in the form of tags for OSM, 
following the customised survey questionnaire (Figure 5). This allows detailed information to be 
securely collected, saved, and uploaded to the server of choice. OMK is an extension that 
launches directly from within ODK, when the OSM question type is enabled in a standard 
survey. It allows the user to browse OSM features, and to create and edit OSM tags. Therefore, 
ODK must also be installed on the Android phone in order to use OMK to collect and edit data in 
OSM. Preparation for this tool included the creation of an OSM base layer, containing the 
footprints of the buildings that were selected for surveying on the ground (Figure 7). This allows 
the mappers to easily identify and select a specific building geometry to add structural details. 
Other useful base layers created by HOT Tanzania for OMK included the boundaries of the 
homogenous zones identified across Dar es Salaam and Pwani. 

 

Figure 7: OpenMapKit Interface, OMK is a free and open source mobile application that works 
with OpenDataKit to collect data in OSM 

 

4.6. TEAM TRAINING 

A full day training session was conducted at the OMDTZ office by one senior civil engineer from 
Ardhi University, Mr. Frank Mushi, that focused on the team becoming experts in the building 
taxonomy that had been created in the data model. The training needed only one full day 
because most of the surveyors have been involved in various projects by using free and open 
applications and how to classify buildings as well. During the training the primary focus was 
training surveyors on details of building structures, materials commonly used in Dar es Salaam 

 

11 http://openmapkit.org 
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and the challenges of visually inspecting buildings from the ground. With this training, the team 
could identify the different attributes necessary to complete the building taxonomy in their 
survey forms. Some specific training materials included: structural building features12, loading of 
structures13, and classification of structures14, which we are including as training resources. On 

the same day, the application and the forms were tested. This training covered the use of the ODK, 
OMK and Maps.me applications on the mobile phones of the surveyors. For this portion of the 
training, the surveyors were taken out to the field where they collected real world data on the 
ground to simulate the actual data collection process (Figure 8). The data that was collected 
during training, was then evaluated to provide feedback to the surveyors, as part of the learning 
process. 

 

 

Figure 8: Team Training at OpenMap Development Tanzania Office. Image © HOT Tanzania 

 

4.7. DATA MANAGEMENT 

After surveying, the data needs to be retrieved from the devices. This can be done simply by 
manually copying the data directly from the mobile phone devices over to a computer, however, 
this does not scale well when there are large numbers of people collecting data. It also means 
the data is generally not backed up until the surveyors return to the office, and if the devices are 
lost, then all the collected data is also lost. HOT Tanzania decided to use a data collection 
server as their central repository for managing the hosting of their questionnaire forms, 
deployments, collection and aggregation of responses. 

 

HOT Tanzania setup an online OpenMapKit (OMK) Server15 to help manage their data flow and 
backup their submissions (Figure 9). A surveyor can retrieve blank questionnaire forms directly 
from the server, and as long as there is internet connectivity, the completed questionnaires can 
be submitted back to the server from the field. The submitted data is then immediately backed 

 

12 https://docs.google.com/presentation/d/1KErOR2YIxey1zdcM-svT_qryhWTzgpnD2yctLP0FbR8/edit 

13 https://drive.google.com/drive/u/0/folders/1cdchSMWzj6vlpouovg6hjkI5N2oaA1Vm  

14 https://drive.google.com/drive/u/0/folders/1cdchSMWzj6vlpouovg6hjkI5N2oaA1Vm  

15 https://github.com/hotosm/OpenMapKitServer  

https://docs.google.com/presentation/d/1KErOR2YIxey1zdcM-svT_qryhWTzgpnD2yctLP0FbR8/edit
https://drive.google.com/drive/u/0/folders/1cdchSMWzj6vlpouovg6hjkI5N2oaA1Vm
https://drive.google.com/drive/u/0/folders/1cdchSMWzj6vlpouovg6hjkI5N2oaA1Vm
https://github.com/hotosm/OpenMapKitServer
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up by the server, greatly reducing the chances of loss. In addition to the deployment of forms to 
ODK, overall data management and automatic backing up of submitted forms, OMK Server also 
provides the ability to view all the surveyed features on a map (Figure 10), as well as filter and 
export selected data. 

 

Figure 9: OpenMapKit Server Table View, data for METEOR project collection in Dar es Salaam 
and Pwani © HOT Tanzania 2019 

 

 

Figure 10: OpenMapKit Server Map View, data for METEOR project collection in Dar es Salaam 
© HOT Tanzania 2019. Base image © MapBox © OpenStreetMap © Maxar 

 

4.8. GROUND SURVEYING 

Once the data management system was set up through the OMK Server, the team was trained 
on how to identify the location of points using OMK with aerial imagery basemap mbtiles on 
their mobile devices. MBTiles is a file format used for storing map tiles as a single file - the most 
common use case as base layers for mobile mapping applications. The imagery used was 
taken by a fixed-wing drone with 10cm resolution, originally collected by COWI in 2016 and 
provided by Tanzania’s Ministry of Lands, Housing and Human Settlements. In addition to the 
imagery the surveyors could see the OSM building footprints in their allocated areas of interest, 
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so that they were able to complete the attribute information following the localised data model 
observed from the ground, and then submit it back to the OMK server once the survey was 
completed (Figure 11). 

This facilitated easy identification of the buildings, where the high contrast of the images 
allowed the team to identify the roof colour, and navigate between buildings to be surveyed. In 
addition, the team was composed of young Tanzanians who were familiar with the areas, 
making the data collection more efficient. For safety reasons, surveyors were divided into 9 
pairs so that they would be working together in the field. 

 

The team used both a clustering method as well as a non-clustering method to allocate the 
sampling points in the six identified zones. These were spread out across the city of Dar es 
Salaam, and some required two hours of transportation time to reach, especially rural 
settlements and some single-family residential zones. To reach these, surveyors used boda 
bodas (motorcycles) to be efficient in terms of time and money.  

 

The houses around each sampling point were chosen and visually inspected by the surveyors. 
The field surveyors were given discretion on how far or near to specific coordinates they could 
move and were advised not to infringe on the 20-metre buffer of another point. Surveyors were 
asked to ignore any points that fell inside restricted zones, such as military compounds. Any 
surveyors encountering difficulties with accessing particular directions of a point were asked to 
collect data in another direction where possible. 

 

Figure 11: OpenMapKit Mobile Application workflow 

 

Throughout the data collection period, weekly meetings were held and used as a place for the 
surveyors to discuss and address any challenges faced. This provided them with the 
opportunity to ask any specific technical questions, learn more about OSM, OMK and OMK 
Server, as well as get feedback on the quality of the data being collected to help iron out any 
issues before continuing on with the data collection. At the end of the data collection a total of 
2,951 buildings were surveyed. Some of these buildings had pre-existing attribute information 
following the tags identified in the localised data model such as building, 

building:neighbor, building:levels, roof:material and roof:shape, while the other 

tags were not present at all. Table 11 shows how the data surveyed through this project has 
added to and enriched the pre-existing attribute information in OSM for the selected buildings in 
Dar es Salaam. 
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Looking at the breakdown of the data values collected for the key attributes, it can be seen that 
the lateral structure materials used for buildings in the surveyed areas of Dar es Salaam are 
roughly 73.7% concrete blocks, 14.2% reinforced concrete, 4% steel, 2% brick and 1% steel-
concrete composite and wood (Table 12). The values for the lateral system are approximately 
62% masonry wall, 14.8% confined masonry, 9% framed concrete structure and 7.5% moment 
resisting frame (Table 13). 

Before going to the field, the team gathered statistics on the building attributes based on the 
digitisation of the buildings. The buildings selected to be surveyed had some attribute 
information before the METEOR Project. After downloading the data using the HOT Export 
Tool, these sample buildings were imported into QGIS and reviewed. By clipping all of the 
buildings according to the boundaries provided by ImageCat, the team was able to later 
compare the attribute information before and after data collection. 

No. Tags Before After % Change 

1 building 1548 2951 47.5% 

2 building:age 206 2951 93% 

3 building:condition 105 2951 96.4% 

4 building:geological_site 0 2951 100% 

5 building:lateral:material 0 2951 100% 

6 building:lateral:system 0 2951 100% 

7 building:levels 1461 2951 50.5% 

8 building:levels:underground 0 2951 100% 

9 capacity:persons 0 2951 100% 

10 roof:material 222 2951 92.5% 

11 roof:shape 0 2951 100% 

12 source 0 2951 100% 

Table 11: Before and After Survey Attribute Information in OSM of sampled buildings in Dar es 
Salaam and Pwani 

 

No. Lateral Materials Count Percentage 

1 concrete_reinforced 419 14.2% 

2 brick 56 1.9% 

3 steel 119 4% 

4 earth 22 - 

5 bamboo 3 - 

6 wood 40 1% 

7 steel-concrete_composite 40 1% 

8 stone 8 - 

9 cgi 14 - 

10 hybrid 2 - 

11 light_gauge_steel 11 - 

12 block 2175 73.7% 

13 mixed 11 - 

14 Industrial_troughed_sheet 7 - 

Table 12: Lateral Materials summary from sampled buildings in Dar es Salaam and Pwani 
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No. Lateral System Count Percentag

e 

1 moment_resisting_frame 221 7.5% 

2 masonry_wall 1835 62% 

3 hybrid 24 1% 

4 braced_frame 17 1% 

5 dual_system (frame wall) 44 1.5% 

6 confined_masonry 437 14.8% 

7 framed_steel_structure 47 1.6% 

8 framed_timber_structure 14 - 

9 framed_conrete_structure 261 9% 

10 shear_wall 51 1.7% 

Table 13: Lateral Systems summary from sampled buildings in Dar es Salaam and Pwani 

 

4.9. DATA VALIDATION 

Validating the data to ensure that it is complete and correct is a key part of the ground data 
collection process. The main objective is to catch any mistakes in the data before uploading it to 
OSM, so that anyone using the information can be confident of the data accuracy. Data 
validation was carried out at four stages by the Tanzania team during the ground data collection 
process. The first phase of data validation is when the data quality specialists are cleaning up 
the information they collected on the ground. There are several tools that can be used to assist 
with data validation, but the tool generally used the most which was also applied by 
HOT/OMDTZ is the use of JOSM (Figure 12). 

 

Figure 12: JOSM (Java OpenStreetMap) Validation Tool for quality assurance of digitised data 
in OSM. JOSM is a free Java software desktop editing tool for OSM data 

This desktop GIS tool is specifically designed for OSM data and can help highlight any errors 
and warnings in the data with the ‘Validation’ tool. Geospatial errors detected include 
intersecting geometries and unconnected nodes, while attribute information errors include 
missing tags, misspelled tags, and incorrectly assigned tags. The ‘TODO’ tool, which is also 
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available in JOSM, allows the user to select all the features in a layer and organise them so that 
they can be reviewed systematically one by one, so that none of them are missed. 

The second phase of data validation took place when 50% of the overall data was collected, 
while the third data validation phase took place when 90% of the data was collected. Both of 
these phases were conducted by the QA specialists. To do this, a CSV file of all the surveyed 
information was downloaded, which was then divided into a few groups based on the mappers 
name or the mobile device ID through which the data was uploaded. Once the data was sorted 
into groups, every tenth row was validated by a QA specialist based on the images gathered by 
the surveyors of the building in question. This process was carried out, so that 10% of all data 
surveyed was validated at the office. 

 

Spot checking was also carried out by visiting the locations of the buildings that fell within the 
10% of the data that had been validated. The building information was checked by the QA 
specialists to ensure that the information on the ground matched the images and data collected 
by the field surveyors (Figure 13). The engineering students from Ardhi University were 
specifically brought on to assist with this validation process. 

    

Figure 13: Building Photos © HOT Tanzania 

 

The fourth and final data validation phase took place after 100% of the data was collected 
through both peer review and GIS experts checking the data in the office. This process involved 
the surveyors reviewing the data of one another in the office and also revisiting some of the 
areas to check if the data was collected well. Therefore, this final validation was done in certain 
zones that had complicated attributes such as Industrial, High Urban and Urban zones. The aim 
of this was to ensure that the information captured is correct and followed the data model. 

 

Data quality assurance goes hand in hand with the data validation process, and ensures that 
the data reaches a minimal level of quality. The higher the quality your data is, the more useful it 
is to end users, so it is essential to manage the process along the way. A tool recently 
developed by HOT aims to support this data quality monitoring process, so that surveying 
teams and their supervisors can easily ensure a certain level of quality. MapCampaigner16 

 

16 https://campaigns.hotosm.org/ 
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assists with the crowdsourcing of data collection and data quality assessment of detailed 
attribute information in OSM. 

Campaigns can be set up on the tool by specifying the area of interest and the features to 
collect detailed information for. The features and their associated attribute information are 
specified through a data model. This tool allows the surveying process and collected data to be 
evaluated, monitoring the overall quality by providing statistics on the number of features 
collected, how much of the area has been covered, attribute completeness, features by type, 
potential errors, as well as information on user engagement. HOT/OMDTZ set up ten projects 
through the MapCampaigner tool for monitoring the quality assurance of the data collected in 
Dar es Salaam. These campaigns are split up by the homogeneous zone types (Table 14). 

 

No. Homogeneous Zone Type MapCampaigner Project 

1 Single Family Residential https://campaigns.hotosm.org/campaign/90c4cc568a5a47d49db343a08d658d1e  

2 Rural Settlement https://campaigns.hotosm.org/campaign/9323035dde544c868793a92844b37c53  

3 Urban Development https://campaigns.hotosm.org/campaign/203467dc917f4f39ad25cace439555b3  

4 Urban_Mixed  https://campaigns.hotosm.org/campaign/ab1e11ac372a4a418e3b78e7b568d61c  

5 Urban Zone 1 https://campaigns.hotosm.org/campaign/473705af7e88403986bd910ab5694b29  

6 Industrial Development Zone 1 https://campaigns.hotosm.org/campaign/6e03da6b7af54bf48d44d5adb0ddc17e  

7 Industrial Development Zone 2 https://campaigns.hotosm.org/campaign/6e03da6b7af54bf48d44d5adb0ddc17e  

8 Informal https://campaigns.hotosm.org/campaign/7316fb4466ce4393879ab9501556c9c1  

9 High Urban Zone 3 https://campaigns.hotosm.org/campaign/ce18d14f52ba45b8a96d0a2e4a11fb27  

10 High Urban Zone 4 https://campaigns.hotosm.org/campaign/35bb6252b9e948ffa53c04a5445c2ef8  

Table 14: Dar es Salaam MapCampaigner Projects 

 

The Tanzania team had some technical challenges with MapCampaigner early in the project, 
specifically it was difficult to add boundaries that contained multi-polygons that are distantly 
dispersed, and this led to initial errors. The team troubleshot these issues, and was able to 
resolve them so that MapCampaigner was used later in the data collection process. Something 
to note is that the campaign links are no longer active (also true of the Nepal data collection), as 
they may have been deactivated with the latest update of the software, but the screenshots in 
Figure 14 and Figure 15 show how MapCampaigner was used during the project, the latter for 
Nepal. One of the benefits of using MapCampaigner was the ability to assess the completeness 
of the attributes collected by the team. 

  

https://campaigns.hotosm.org/campaign/90c4cc568a5a47d49db343a08d658d1e
https://campaigns.hotosm.org/campaign/9323035dde544c868793a92844b37c53
https://campaigns.hotosm.org/campaign/203467dc917f4f39ad25cace439555b3
https://campaigns.hotosm.org/campaign/ab1e11ac372a4a418e3b78e7b568d61c
https://campaigns.hotosm.org/campaign/473705af7e88403986bd910ab5694b29
https://campaigns.hotosm.org/campaign/d0ad90f2a7504cbf9d91453080336093
https://campaigns.hotosm.org/campaign/6e03da6b7af54bf48d44d5adb0ddc17e
https://campaigns.hotosm.org/campaign/7316fb4466ce4393879ab9501556c9c1
https://campaigns.hotosm.org/campaign/ce18d14f52ba45b8a96d0a2e4a11fb27
https://campaigns.hotosm.org/campaign/35bb6252b9e948ffa53c04a5445c2ef8
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Figure 14: Dar es Salaam High Urban Homogeneous Zone 1 within MapCampaigner interface. 
Leaflet | © MapBox © OpenStreetMap 

 

  

Figure 15: Example of attribute Information for data in Kathmandu, Nepal as part of METEOR 
Report M4.4/P (O’Hara & Thapa, 2019) viewed in (left) MapCampaigner and (right) OSM. OSM 
was edited on Fri, 01 Mar 2019 05:51:52 +0000 (access shown from 2023). Data © 
OpenStreetMap contributors, licensed under ODbL 
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5. Open Access 

5.1. DATA EXTRACTS 

The final collected and validated Dar es Salaam data, is now hosted on OSM and available for 
anyone to access and use. There are multiple ways to extract data from OSM such as the use 
of Overpass Turbo or JOSM, but for those with little to no experience with OSM, the Export 
Tool17 is recommended. The Export Tool was created by HOT as a way to provide individuals 
with low technical skills to easily extract data from OSM through a user-friendly interface and 
straightforward process. 

The Export Tool allows users to create custom OSM data extracts for anywhere in the world, 
simply by selecting an area of interest (Figure 16), map features (Figure 18) and file formats to 
convert the data into (Figure 17). Within minutes, up-to-date OSM data is exported (Figure 19). 

 

 

Figure 16: Describe Tab – Create Export Tool Function, for customising OSM data extract area. 
Data displayed © OpenStreetMap contributors and © MapBox 

 

 

Figure 17: Formats Tab – Create Export Tool Function, for customising OSM export format. 
Data displayed © OpenStreetMap contributors and © MapBox 

 

17 https://export.hotosm.org/ 
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Figure 18: Data Tab – Create Export Tool Function, for customising OSM map features extract. 
Data displayed © OpenStreetMap contributors and © MapBox 

 

 

Figure 19: Summary Tab – Create Export Tool Function, for the proposed extracted OSM data. 
Data displayed © OpenStreetMap contributors and © MapBox 

 

The only requirement to use the Export Tool is to sign in with an OSM username and provide an 
email address, which is used to send a link of completed jobs in case the connection is lost, the 
export will still run and notified the user once it is ready. 

 

A job has already been set up on the Export Tool for the Dar es Salaam data (Figure 20), which 
can be found in Table 15. The data is extracted from OSM using the source = “METEOR Dar es 
Salaam Field Survey 2019” tag, which was applied to each of the buildings surveyed by the 
team. This selects the specific buildings within the area of interest, and then filters the attributes 
based on those identified in the YAML syntax in the ‘Feature Selection’ tab of the Tool. 

 

There are multiple file formats to choose from, but only the GeoPackage and pbf formats have 
been selected. If other formats are desired, the job can be ‘Cloned’ and the settings changed 
before running the job again. The file can be downloaded by clicking on the highlighted link on 
the export page once it has finished running. 
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Figure 20: Export Page – Completed Job, for the customised OSM data extraction. Data 
displayed © OpenStreetMap contributors and © MapBox 

 

Dar es Salaam Data Extract 

https://export.hotosm.org/en/v3/exports/c1f46025-6f93-4957-925d-83fed720a51b  

Table 15: Export Tool Data Extract (NOTE: export data older than 30 days is deleted) 

 

5.2. METHODOLOGY 

Creating data in OSM is not the only aim of HOT-led projects, but providing open access to the 
methodology and tools applied is also at the core. Sharing knowledge is the best way to 
increase awareness of the issues and goals at hand, which also allows for the sustainability of 
the data in the years to come. 

 

One of the ways in which the project methodology is shared with the greater community is 
through the OSM wiki18 (Figure 21, Table 16). The wiki is a common place for documenting 
projects related to creating data in OSM. It is also the first place that should be checked for 
similar projects conducted in the targeted area of interest. This way the processes and lessons 
learned can be reviewed and built upon. It is also common to provide the details of the project 
manager who can be contacted for further discussions regarding the work and provide 
feedback. 

 

 

18 https://wiki.openstreetmap.org/ 

https://export.hotosm.org/en/v3/exports/7607cd74-5864-4923-b7fc-88cbbad77aa3
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Figure 21: Tanzania METEOR Wiki Page, for the editing activities undertaken by HOT Tanzania 
for Dar es Salaam and Pwani mapping in the METEOR project 

 

Local Partner 

Organisation 

Link 

OpenMap Development 

Tanzania/Ramani Huria 

https://wiki.openstreetmap.org/wiki/METEOR_Project_in_Tanzania#METEOR_Project

_in_Tanzania 

Table 16: Dar es Salaam METEOR Wiki Page Link 

 

The OpenStreetMap Foundation provides an overview on the expectations for organised editing 
efforts in OSM through their ‘Organized Editing Guidelines’ page.19 Their goal is to provide a 
framework to both organised mapping initiatives and the communities to encourage good 
organised mapping, which will assist with the sustainability and usability of the data created. 
The organised editing guidelines apply to any edits that involve more than one person and can 
be grouped under one or more sizeable, substantial, coordinated editing initiatives. One of the 
key sections of the guidelines focus on the creation of a wiki page, to assist with the recording 
and sharing of activities with the rest of the OSM community for constructive feedback. 

 

A page for the METEOR project has been set up on the HOT website20, with contact details for 
the project manager, as well as links to news update blogs and other key pages related to the 
work. In addition, OpenMap Development Tanzania have set up a project page on the OSM wiki 
(Table 16) for the data created in Tanzania, as part of the METEOR project following the OSM 
Foundation ‘Organized Editing Guidelines’. The main sections of the wiki page include an 
overview of the project (manager, contact details, time frame, etc), the purpose and goal, as 
well as details of the data creation process. This includes links to the Tasking Manager projects, 
imagery used, building statistics before and after the digitisation stage (quantity and quality), as 
well as before and after maps of the homogeneous zones for the remote digitisation phase. The 
localised OSM data model derived from the GED4ALL schema, tools used for the data 
collection, statistics of attribute completeness before and after data collection, statistics of data 
quantity and quality before and after surveying are also provided through the wiki page. 

 

19 https://wiki.osmfoundation.org/wiki/Organised_Editing_Guidelines 

20 https://www.hotosm.org/projects/modelling-exposure-through-earth-observation-meteor/  

https://wiki.openstreetmap.org/wiki/METEOR_Project_in_Tanzania#METEOR_Project_in_Tanzania
https://wiki.openstreetmap.org/wiki/METEOR_Project_in_Tanzania#METEOR_Project_in_Tanzania
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While the wiki page provides more of an overview to the METEOR project aim, methodology, 
tools and results, it does not go in depth on how to set up a mapping project and apply the 
appropriate tools. Outlining the steps in the METEOR report on the protocols for crowd-sourcing 
of the regional exposure data (O’Hara, 2019) is not the most effective way to reach a larger 
audience, as HOT has seen in the past and are currently developing an open online ‘HOT 
Toolbox’ that will host all of the methodologies applied for setting up and executing mapping 
projects (Figure 22, Table 17). The site includes presentation, videos and the ability to export 
materials as PDFs. It covers a range of topics spanning from designing and coordinating a 
mapping project, to data use and analysis. This will continually evolve as the methodologies 
applied by HOT also change to reflect the lessons learned and the emergence of new better 
equipped tools are developed. 

 

Figure 22: HOT Toolbox 

 

Open Access Training 

Material 

Link 

HOT Toolbox https://hotosm.github.io/toolbox/ 

Table 17: HOT Toolbox Link 

6. Sustainability 

A common concern about crowd-sourcing mapping initiatives is their ability to have a 
sustainable impact after the end of the project cycle. In this case, sustainability can take on 
multiple meanings, including continuing use and maintenance of the data, continued activity of 
the local mapping community, or ongoing investment in the project by new participants. Defining 
at the start of the process, what goals are the most relevant to help the sustainability of the data 
will more likely achieve them. It is also important to take stock at the end of a project of what 
was learned during the implementation, in order to guide continued work or new efforts in other 
locations. Key goals for the sustainability of the METEOR ground data collection was the 
creation of open access information on the project itself, including the aim, methodology, tools 
and results through the OSM wiki page, as well as the HOT Toolbox where interested parties 
can access more detailed steps on how to set up their own mapping projects. 

 

https://hotosm.github.io/toolbox/
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Other aspects of the data collection focused on the sustainability of the project, includes the use 
of the ‘source=METEOR Dar es Salaam Field Survey 2019’ tag, which allows users to see and 
reference how the data was created. Reading the open access documents and protocols on the 
mapping project can work as a guide to support similar mapping activities in the area to 
enhance the data or to simply keep it up-to-date. Similarly, the ‘fixme=*’ tag was also applied to 
the data collected. This tag was used to describe any mapping errors discovered by the 
surveyors on the ground. For example, the “north side of the building is attached to a 
neighbouring wall” or “the building complex is actually 4 separate buildings evenly divided”. This 
tag was included in the ground data collection model to maximise the improvement of OSM. It 
has also made it easier for the OSM Tanzania community to continue improving OSM beyond 
the project period. 

 

Since HOT’s partner OMDTZ is a local organisation based in Dar es Salaam, Tanzania, they 
plan to monitor the data uploaded to OSM. They work on several OSM-related projects 
throughout the year, and will continue to do so in the future as they are an integral part of the 
OSM community across all of Tanzania, and act as a point of contact and reference for related 
mapping projects in the country. MapCampaigner was a new tool introduced to OMDTZ on the 
METEOR project, which they hope to continue to utilise going forward as it helps the teams to 
monitor specific data in OSM. 

 

7. Conclusion 

Overall the ground data collection effort was successful, providing OSM data at the building 
level for 2951 randomly selected structures within the 6 homogeneous development type zones 
in Dar es Salaam and the neighbouring region of Pwani. The OSM data will then be used by 
ImageCat to aggregate and smear for the rest of Tanzania to create exposure datasets at 
higher levels. 

 

One of the qualities that makes the METEOR Project unique is its effort to calibrate the Earth 
Observation exposure data with testing and validation via on the ground data collection in Nepal 
and Tanzania. In many ways, the data collection in Dar es Salaam has followed closely along 
the same lines as in Kathmandu, by using the protocols for crowd-sourcing exposure data 
(O’Hara, 2019). At the same time, everything from the data model to the data collection has 
been tailored to the context of Tanzania, ensuring that the outputs are fit-for-purpose. However, 
no data collection project is ever perfect, and this one is no exception. Building on the lessons 
from Nepal (O’Hara & Thapa, 2019), some of the work in Tanzania was improved, while new 
insights were learned. Moving forward, these will be helpful for communities to improve the way 
data is created in OSM to meet its intended purpose. 

 

Among the takeaways HOT would like to share is the idea that certain building classifications 
may differ country to country, for instance ‘informal settlement’. In Nepal, informal settlements 
often refer to slums, and their physical form (structure of the building) as well as vulnerability is 
different than in Tanzania. In Tanzania, and Dar es Salaam specifically, it is known that up to 
70% of the city is informal, which indicates a high level of socioeconomic vulnerability as many 
live in unplanned, untitled plots. Yet in terms of building structure, these are usually built with 
concrete blocks and corrugated metal roofs, reducing their vulnerability when compared with 
actual slums. 

 

Another takeaway that HOT would like to emphasise is the finding that the profile of rural areas 
is significantly different than that of Dar es Salaam. Thus, extrapolating from the city to wider 
Tanzania may produce a less representative sample. Buildings that are made of mud are 



37 

considered to be more vulnerable, and these are found primarily in remote areas outside of 
cities, examples being the Arusha or Manyara Regions. Though these buildings are often more 
vulnerable, the risk depends on where they exist and whether they are exposed to potential 
natural hazards. The Tanzania team had even planned on doing supplementary fieldwork to 
enhance the model with additional exposure sets, but with the onset of the COVID-19 
pandemic, HOT confirmed with ImageCat that the data already provided would be sufficient to 
the modelling. 

 

It should also be kept in mind that the data collection methods applied for the METEOR project 
are by no means an exhaustive and comprehensive reference for all the processes and tools 
that can be used for collecting data in OSM. No one solution fits all, and an approach should be 
formulated based on the data collection focus, the local community and the targeted area of 
interest. Approaches that work in one country might not work in another, and newer more 
appropriate tools for data collection may become available. However, the completion of ground 
data collection in Dar es Salaam does give evidence that the established protocols and tools will 
be relevant for other ODA nations. 

 

HOT has been conducting OSM data collection for over seven years, and the methodology is 
continuously evolving as lessons are learned, and processes become more streamlined. Many 
of our software development projects are focused on assisting the creation, extraction and 
analysis of OSM data. Helping provide the tools to empower local citizens with the capacity to 
place themselves on the map, is one of the biggest contributions we can make towards the 
OSM community as we work towards the Sustainable Development Goals (SDGs) together.  

 

Accomplishing the key aims of the METEOR Project still necessitates further engagement so 
that the exposure data can connect with resilience efforts, risk assessments, and Disaster Risk 
Management plans. As the project shifts from the data collection and modelling phase towards 
knowledge sharing, sustainability, and capacity-building, HOT and our local partner OMDTZ 
remain ready to facilitate and achieve the broader goals of the project. 
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Appendix 1: Homogeneous Zone Maps 

 

Figure 23: METEOR Dar es Salaam and Pwani Homogeneous Zone 1 (Industrial) © ImageCat, 
inc. Data displayed within OSM © OpenStreetMap contributors, licensed under ODbL 

 

 

Figure 24: METEOR Dar es Salaam and Pwani Homogeneous Zone 2 (High Urban) © 
ImageCat, inc. Data displayed within OSM © OpenStreetMap contributors, licensed under 
ODbL 
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Figure 25: METEOR Dar es Salaam and Pwani Homogeneous Zone 3 (Informal) © ImageCat, 
inc. Data displayed within OSM © OpenStreetMap contributors, licensed under ODbL 

 

 

Figure 26: METEOR Dar es Salaam and Pwani Homogeneous Zone 4 (Single Family 
Residential) © ImageCat, inc. Data displayed within OSM © OpenStreetMap contributors, 
licensed under ODbL 
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Figure 27: METEOR Dar es Salaam and Pwani Homogeneous Zone 5 (Rural Settlement) © 
ImageCat, inc. Data displayed within OSM © OpenStreetMap contributors, licensed under 
ODbL 

 

 

Figure 28: METEOR Dar es Salaam and Pwani Homogeneous Zone 6 (Urban) © ImageCat, inc. 
Data displayed within OSM © OpenStreetMap contributors, licensed under ODbL 
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Appendix 2: Attribute Value Breakdown 

No. Building Count Percentage 

1 residential 1578 53.5% 

2 mixed_use 343 11.6% 

3 commercial 479 16% 

4 government 29 1% 

5 educational 12 - 

6 industrial 364 12% 

7 agriculture 2 - 

8 public 120 4% 

9 construction 16 1% 

10 toilet 1 - 

11 assembly 6 - 

12 health 1 - 

 

No. Building Neighbor Count Percentag

e 

1 attached 967 32.8% 

2 free_standing 1984 67.2% 

 

No. Building Age Count Percentag

e 

1 post_2000 1886 63.9% 

2 pre_2000 1065 36.1% 

 

No. Building 

Condition 

Count Percentag

e 

1 good 1452 49.2% 

2 average 1224 41.5% 

3 poor 275 9.3% 
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No. Geological Site Count Percentag

e 

1 flat_land 2485 84.2% 

2 slopy_land 331 11.2% 

3 river_bank 17 1% 

4 flood_prone_area 118 4% 

 

No. Building Levels Count Percentage 

1 1 2596 88% 

2 2 136 4.6% 

3 3 57 1.9% 

4 4 41 1.4% 

5 5 21 1% 

6 6 29 1% 

7 7 13 - 

8 8 17 1% 

9 9 4 - 

10 10 6 - 

11 11 6 - 

12 12 7 - 

13 13 3 - 

14 14 4 - 

15 15 2 - 

16 19 1 - 

17 20 1 - 

18 21 1 - 

19 23 1 - 

20 25 1 - 

21 26 1 - 

22 28 1 - 

23 31 1 - 

24 35 1 - 
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No. Building Levels 

Underground 

Count Percentage 

1 none 2923 99% 

2 1 27 1% 

3 2 1 - 

 

No. Capacity 

Person 

Count Percentage 

1 10 to 19 687 23% 

2 20 to 49 303 10% 

3 5 to 9 924 31% 

4 50 to 100 146 5% 

5 500 and above 2 - 

6 300 to 500 11 - 

7 200 to 300 58 2% 

8 100 to 200 277 9% 

9 Less than 5 542 18% 

10 Less than 9 1 - 

 

No. Roof Material Count Percentage 

1 concrete 375 12.7% 

2 cgi 2095 71% 

3 mixed 15 1% 

4 wood 1 - 

5 unknown 60 2% 

6 slate 1 - 

7 composite_tiles 40 1% 

8 thatch 11 - 

9 earth 1 - 

10 fabric 20 1% 

11 metal 165 5.6% 

12 clay_tiles 140 4.7% 

13 stone 1 - 

14 Industrial_troughed sheet 25 1% 

155 glass 1 - 
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No. Roof Shape Count Percentage 

1 flat 486 16.5% 

2 monopitch 607 20.6% 

3 double_pitch 312 10.6% 

4 complex_regular 112 3.8% 

5 pitched 1350 45.7% 

6 unknown 56 1.9% 

7 complex_irregular 9 - 

8 curved 13 - 

9 sawtooth 3 - 

10 domed 3 - 

 

  



45 

Appendix 3: Sampling Procedure for Buildings 

Goal 

The goal is a statistically valid random and systematic procedure to select a subset of buildings 
that generates clusters (groups of buildings in close proximity) so that field mapping is efficient. 

If the sampling rate is so high as to generate a large number of overlaps (for example, if the 
desired sampling rate is 400 out of 434 buildings, as is the case in the Industrial zone of Dar es 
Salaam in our current project), clustering does not makes sense; most buildings are part of 
more than one cluster. 

Therefore, we have applied the following rule: if the desired sample is more than 1/3 of the total 
buildings, we select a random subset of those buildings without clustering. If the desired sample 
is less than 1/3 of the total structures, we use the clustered random sampling procedure 
described below. 

Procedures 

Non-clustered sampling 

This procedure simply generates a random sample of the structures without taking proximity 
into account. We use the randomly generated ranking number to order the buildings and select 
the required number from the ordered ranking. 

The random ranking number is generated using the QGIS Field Calculator (under the hood this 
is the Python random number generator). We add a new column to the attribute table of the 
building layer, in which the function rand({min}, {max}) generates a random integer. We 

use zero and one billion as our min and max—this large number is to avoid any potential 
duplicates—and select the appropriate number of buildings (in our current project 400) with the 
lowest random number. 

• Use the QGIS Field Calculator, create a new column in the building layer with Output field 
name random, choose Whole number (integer) as the type, and the expression rand 

(0, 1000000000) to populate the new column. Save the changes and exit editing mode. 

• In the Attribute Table of the building layer, click the column header of the Random column. 
This will order the entire dataset by the random number, creating a sequential ranking. 
Select the first n elements (in our case 400), and in the Layers panel select Export -> 

Save Selected Features As and create a new GeoPackage with an appropriate 

name. This GeoPackage will be your random sample. 

 

Clustered sampling 

First, prepare your files and data. Keep things organised—name your files, put them in 
appropriately named folders, and name your layers in QGIS! 

• Load up the zones and buildings as layers in QGIS. Split the zones into multiple files using 
Vector -> Data Management Tools -> Split Vector Layer selecting 

typeclean as the Unique ID Field. That will create a new shapefile for each type of area. 
Load the resulting shapefiles into the project in a single folder. 

o NOTE: the QGIS Split Vector Layer tool only outputs shapefiles, not 
GeoPackages. This is OK for the zones in this procedure, but should not be used 
for buildings (or any other OpenStreetMap layer from which we need the attributes, 
as the Shapefile format truncates all attribute table headers to 10 characters, which 
results in a lot of mysterious columns). 

Now we need to create random points within the zones. Since each zone may be multiple 
polygons, we cannot simply choose a number of points, as we need a consistent density of 
points in all polygons within one zone. To do this, we calculate a required density of points per 
square meter for each zone and apply this across all the polygons in that zone. First, we 
calculate the areas of all zones. 
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• Go to each new layer, open the Attribute Table, and use the Field Calculator to create new 
field called area, select type decimal number (real) selecting Geometry -> $area. 

• Run the Vector -> Analysis Tools -> Basic Statistics for Fields tool 

for each layer. we need the SUM of the area column, so choose area as the Field to 
calculate statistics on, and copy the SUM from the resulting log (this will be an area in 
square meters) into another document. Keep this handy. 

Now we can generate random points in the zone polygons to use as the centres for our clusters. 
In the example here, we wish to select 400 buildings in clusters of 10. However, if we create 
only 40 random points, some will be sufficiently close to one another that their clusters overlap 
(some buildings will be within the nearest 10 of more than one cluster centre). Therefore, we will 
create more points than seem necessary to select more buildings than we need (overshoot 
rather than undershoot), and later remove the excess buildings in a systematic fashion. Let's 
create 60 random points per zone rather than 40 (the expression below uses 60 as the number 
of points to divide by the number of square meters in each zone). 

• Go to Vector -> Research Tools -> Random Points in Polygon. Choose 

Points Density as the sampling strategy, and use the expression 60 / {SUM} where 

SUM is the number we got from the Basic Statistics for Fields (use that number, don't type 
out the word SUM). This expression gives us a very tiny number, something like 0.00005, 
that represents the number of points per square meter. when we press Run, the chosen 
number of points (in this case 60) will be created at a consistent density across all 
polygons in the zone. 

Before going further, we need to add a random number attribute into the random point layer, as 
well as to the building layer (just as we do for non-clustered sampling). This random ranking 
attribute is used to remove the buildings exceeding the number needed (in our case 400). To 
retain the clustering, we will first remove the buildings associated with the highest-scoring 
random points. Since this probably won't get us to our exact target (since in our case each point 
has around 10 buildings associated with it, so there will be zero to nine excess buildings left 
after removing the excess clusters), we'll trim off the remaining excess buildings using the 
random scores of the buildings themselves. 

• Use the QGIS Field Calculator, create a new column in the building layer with Output field 
name random, choose Whole number (integer) as the type, and the expression rand(0, 

1000000000) to populate the new column. 

• Then do the same thing with the random points layer. 

Now we wish to select the 10 closest buildings around each random point. The QGIS Distance 
Matrix tool will do this, but it only works on points, not polygons. So, we will generate centroids 
for the building polygons. 

• Create centroid points for the building layer using Vector -> Geometry Tools -> 

Centroids. The resulting layer should have all the same attributes as the buildings, 

including the OSM ID (probably a column called osm_id). 

• Now go to Vector -> Analysis Tools -> Distance Matrix. Your input layer is 

Random Points, and your target layer is Centroids. The "Target unique ID field" should be 
the osm ID. Output matrix can be linear and in the field for "Use only the nearest (k) target 
points,", put 10. This should give us a new layer called Distance Matrix that contains only 
the 10 nearest building centroids from each random point. 

Some building centroids may be among the 10 nearest to more than one random point, in which 
case the total number of points in the Distance Matrix will not be 10X the number of random 
points. This is why we used more points than 1/10 the number of buildings needed (in this case 
60 rather than 40). 

Now we need to link the chosen centroids back to the original building layer. While we're at it, 
we'll add the random ranking number from the random points to the Attribute Table of the 
building layer—we'll use that to remove the excess structures first by removing those from the 
excess random points (and therefore clusters), then by trimming off the remaining excess 
buildings. 



47 

• Open the Properties of the buildings, go to Joins, and push the green plus button on the 
bottom to add a new join. The Join layer is Distance matrix, the join field is TargetID, and 
the Target field is osm_id (or whatever the column with the OSM ID is called). Custom 
Field Name Prefix should be DM_ (or something equally short), and Joined Fields should 
be InputID only (this will create a column in the building layer with the random ranking 
number of the random point it is associated with). 

• Open the Attribute Table of the building layer, and look at the last column on the right 
(called DM_InputID if we followed these instructions carefully). It should be blank for some 
buildings (the ones that don't fall into the selected clusters), and contain a number from 
zero to one billion in a few rows. Sort the column so that all of the buildings with a 
DM_InputID are on top, select them all, close the Attribute Table, and right-click on the 
building layer. 

• Choose Export -> Save Selected Features As and save this as a new 

GeoPackage -- it will contain only the buildings within the clusters for that particular 
sampling zone. 

• However, this file still contains too many buildings! So we sort again in ascending order, 
first by the Random column, then by the DM_InputID column. Now the we can select the 
first n* buildings (for us 400) and delete the rest (by entering editing mode, pressing the 
*Invert selection button, and pressing the delete button. Because of the sort order (first by 
the building random number, then by the cluster random number which is in the 
DM_InputID column), this will retain the clustering by trimming first the buildings belonging 
to the excess clusters, then the excess buildings in the final cluster (so the last cluster 
may have as few as 1 building in it, but all of the others will include the nearest 10 to their 
random point). 
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Appendix 4: Online Interactive Map, Dar es Salaam 
METEOR Buildings and Ward Boundaries 

 

Figure 29: Interactive map for METEOR buildings and ward boundaries. uMap: 
https://umap.openstreetmap.fr/en/map/meteor_tz_buildings_417725#17/-6.81326/39.28848. 
Map data © OpenStreetMap contributors, licensed under ODbL 

 

*Note: Images were previously linked for data validation, currently are no longer being hosted. 
Images taken during data collection are available, and have been provided as “TZ METEOR 
Data with Photos” including a GeoPackage of the data with a field for image ID, along with a 
folder containing all images. 
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